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Converting	currency	in	Excel	might	seem	daunting,	but	it’s	really	quite	simple	once	you	know	the	steps.	With	just	a	few	clicks,	you	can	convert	dollars	to	euros,	yen	to	pounds,	or	any	other	currency	you	might	need.	All	you	need	is	a	little	know-how	and	the	right	formula.	After	reading	the	quick	overview	below,	you’ll	be	able	to	convert	currency	like	a
pro.	Before	we	dive	into	the	steps,	let’s	understand	what	we’re	trying	to	achieve.	Converting	currency	in	Excel	involves	using	a	formula	that	takes	into	account	the	current	exchange	rate.	This	way,	you	can	convert	amounts	from	one	currency	to	another	accurately.	First,	you	need	to	find	the	current	exchange	rate	for	the	currencies	you	want	to
convert.	Exchange	rates	are	always	changing,	so	it’s	important	to	use	the	most	up-to-date	information.	You	can	find	this	information	on	financial	news	sites,	through	a	quick	internet	search,	or	by	using	Excel’s	built-in	data	types	feature.	Next,	enter	the	amount	you	want	to	convert	into	a	cell	in	Excel.	This	is	the	easy	part.	Just	type	in	the	amount
without	any	currency	symbols.	For	example,	if	you’re	converting	100	US	dollars,	just	type	“100”	into	the	cell.	Now,	use	the	formula	=A1*B1	(replace	A1	and	B1	with	your	actual	cell	references)	where	A1	is	the	amount	to	convert,	and	B1	is	the	exchange	rate.	This	formula	will	multiply	the	amount	you	want	to	convert	by	the	current	exchange	rate,
giving	you	the	converted	amount	in	the	new	currency.	Finally,	format	the	cell	with	the	conversion	result	as	currency.	To	do	this,	right-click	on	the	cell,	select	‘Format	Cells’,	and	then	choose	‘Currency’	from	the	categories.	You	can	even	select	the	specific	currency	you	want	to	display	from	a	dropdown	list.	Once	you’ve	completed	these	steps,	you’ll	see
the	converted	currency	amount	in	Excel,	calculated	using	the	current	exchange	rate.	It’s	that	simple!	Always	double-check	the	exchange	rates	for	accuracy	before	converting	large	amounts.	Remember	to	format	your	cells	correctly	to	reflect	the	currency	you’re	working	with.	Use	Excel’s	data	types	feature	to	automatically	update	exchange	rates	for
real-time	conversions.	Consider	adding	a	date	stamp	when	you	record	exchange	rates	for	historical	tracking.	Make	use	of	Excel’s	functions	like	VLOOKUP	or	XLOOKUP	to	streamline	the	conversion	process	if	you’re	working	with	multiple	currencies	regularly.	Yes,	Excel	can	automatically	convert	currency	using	the	data	types	feature	which	pulls	in	live
exchange	rate	data.	If	you’re	using	the	data	types	feature,	Excel	will	update	the	rates	for	you.	Otherwise,	you	will	need	to	manually	update	them	to	ensure	accuracy.	The	accuracy	of	currency	conversion	in	Excel	depends	on	the	exchange	rate	data	you	use.	Using	live	data	types	ensures	higher	accuracy.	Yes,	by	using	functions	like	VLOOKUP	or
XLOOKUP,	you	can	set	up	a	conversion	table	and	convert	multiple	currencies	simultaneously.	No,	there’s	no	limit	to	the	amount	you	can	convert.	However,	remember	that	the	more	data	you	work	with,	the	more	important	it	is	to	ensure	accuracy.	Obtain	the	current	exchange	rate.	Input	your	amount.	Use	the	conversion	formula.	Format	the	result	as
currency.	Excel	is	a	powerful	tool	that	can	simplify	many	tasks,	including	currency	conversion.	By	understanding	and	utilizing	the	steps	outlined	in	this	article,	you’re	now	equipped	to	handle	currency	conversions	efficiently	and	accurately.	Remember,	the	key	to	successful	currency	conversion	in	Excel	is	using	up-to-date	exchange	rates	and	formatting
your	results	correctly.	Whether	you’re	a	business	owner	keeping	track	of	international	transactions,	a	traveler	planning	a	budget	for	your	next	trip,	or	a	student	working	on	an	economics	project,	mastering	currency	conversion	in	Excel	is	a	valuable	skill.	And	with	the	tips	and	frequently	asked	questions	we’ve	covered,	you	should	be	even	more
prepared	to	navigate	any	currency-related	challenges	that	come	your	way.	So,	go	ahead,	give	it	a	try!	You	might	just	find	that	converting	currency	in	Excel	becomes	second	nature	to	you.	And	who	knows?	You	might	even	become	the	go-to	person	for	currency	conversion	among	your	friends	and	colleagues.	Happy	converting!	Matthew	Burleigh	has
been	writing	tech	tutorials	since	2008.	His	writing	has	appeared	on	dozens	of	different	websites	and	been	read	over	50	million	times.	After	receiving	his	Bachelor’s	and	Master’s	degrees	in	Computer	Science	he	spent	several	years	working	in	IT	management	for	small	businesses.	However,	he	now	works	full	time	writing	content	online	and	creating
websites.	His	main	writing	topics	include	iPhones,	Microsoft	Office,	Google	Apps,	Android,	and	Photoshop,	but	he	has	also	written	about	many	other	tech	topics	as	well.	Read	his	full	bio	here.	1	Look	up	your	current	conversion	rate.	Open	a	web	browser	and	type	currency	converter	into	the	address	bar,	then	select	the	currencies	you	want	to	compare
in	the	drop-down	boxes	at	the	top	of	the	search	engine's	results.	This	will	give	you	the	current	conversion	rate.	For	example,	if	you	wanted	to	see	the	conversion	rate	for	euros	to	US	dollars,	you	would	select	Euros	for	the	top	box	and	Dollars	for	the	bottom	box.	2	Open	Microsoft	Excel.	It's	a	green	app	with	a	white	"X"	on	it.	Advertisement	3	Click	Blank
workbook.	You'll	find	this	option	in	the	upper-left	side	of	the	window.	On	Mac,	click	the	New	tab	and	then	click	Blank	Workbook.	4	Create	a	chart	with	your	currency	conversion	information.	To	do	so:	Type	the	first	currency's	name	into	A1	(e.g.,	"Dollars").	Type	the	first	currency's	value	into	B1.	This	value	should	be	"1".	Type	the	second	currency's
name	into	A2	(e.g.,	"Euros").	Type	the	conversion	rate	into	B2.	5	Type	your	starting	currency's	name	into	D1.	For	example,	if	you're	converting	dollars	to	euros,	you	would	type	"Dollars"	into	the	D1	cell.	6	Type	the	currency	values	you	wish	to	convert	into	the	"D"	column.	For	example,	if	you	have	ten	dollar	amounts	that	you	want	to	convert	to	euros,
you	would	enter	each	dollar	value	in	a	cell	from	D2	through	D11.	7	Type	the	conversion	currency's	name	into	E1.	To	use	the	previous	example,	you	might	type	"Euros"	here.	8	Click	E2,	then	type	in	=$B$2*D2	and	press	↵	Enter.	This	will	display	the	converted	equivalent	of	your	starting	currency	in	cell	E2,	which	is	directly	to	the	right	of	the	starting
currency	equivalent.	9	Apply	the	formula	to	the	rest	of	the	second	currency's	column.	Click	E2	again	to	select	it,	then	double-click	the	little	green	square	that	appears	in	the	bottom-right	corner	of	the	E2	cell.	Your	second	currency's	column	will	fill	up	with	conversions	of	the	currency	values	from	the	starting	currency	column.	Advertisement	1	Go	to
the	Kutools	download	page.	Visit	in	your	browser.	Kutools	is	only	available	for	Windows.	2	Click	Free	Download	Now.	It's	a	link	in	the	middle	of	the	page.	Doing	so	will	download	Kutools	to	your	computer,	though	you	may	need	to	click	Save	or	choose	a	download	location	depending	on	your	browser.	3	Double-click	the	Kutools	setup	file.	It	resembles	a
brown	box.	4	Select	a	language,	then	click	OK.	Click	the	drop-down	box	to	pick	a	language.	5	Follow	the	on-screen	prompts.	To	finish	installing	Kutools:	Click	Next.	Click	the	"Accept"	box	and	click	Next.	Click	Next	twice.	Click	Install.	6	Open	Microsoft	Excel.	It's	a	green	app	with	a	white	"X"	on	it.	7	Click	Blank	workbook.	You'll	find	this	option	in	the
upper-left	side	of	the	window.	8	Enter	your	starting	currency	values	in	the	"A"	column.	For	example,	if	you	have	20	dollar	values	you	want	to	convert,	you'll	place	each	individual	value	in	cells	A1	through	A20.	9	Select	the	starting	currency	data.	Click	the	A1	cell	and	drag	all	the	way	down	to	the	last	full	cell.	10	Copy	the	data.	Click	the	Home	tab,	then
click	Copy	in	the	"Clipboard"	section	on	the	left	side	of	the	toolbar.	11	Paste	the	data	into	the	"B"	column.	Click	the	B1	cell,	then	click	the	Paste	button.	This	button	resembles	a	clipboard	in	the	far-left	side	of	the	Home	toolbar.	Make	sure	you	click	the	clipboard	icon	and	not	the	arrow	below	it.	12	Select	the	data	in	the	"B"	column.	Simply	click	the	B
column	header	to	select	all	cells	in	the	"B"	column.	13	Click	the	Kutools	tab.	This	is	near	the	top	of	the	Excel	window.	14	Click	Currency	Conversion.	It's	in	the	"Ranges	&	Content"	group	of	options	in	the	toolbar	at	the	top	of	the	page.	15	Click	Update	rate.	It's	a	button	in	the	upper-left	side	of	the	Currency	Conversion	page.	This	will	ensure	that	your
currency	rate	is	as	accurate	as	possible.	You	will	need	to	have	an	Internet	connection	for	this	to	work.	16	Select	your	data's	current	currency.	Do	so	in	the	window	on	the	left	side	of	the	Currency	Conversion	page.	For	example,	if	you're	converting	from	dollars	to	euros,	you	would	select	Dollars	here.	17	Select	the	currency	you	want	to	convert	your
data	to.	Do	this	in	the	window	on	the	right	side	of	the	Currency	Conversion	page.	For	example,	if	you're	converting	from	dollars	to	euros,	you	would	select	Euros	here.	18	Click	OK.	This	will	convert	the	values	in	the	"B"	column	to	the	currency	you	chose	to	convert	to.	Kutools	isn't	free	to	use	forever.	If	you	want	to	continue	to	use	Kutools,	you'll	have	to
purchase	it	from	the	Extended	Office	store.	Advertisement	Ask	a	Question	Advertisement	Thanks	Advertisement	Thanks	Advertisement	Written	by:	wikiHow	Technology	Writer	This	article	was	co-authored	by	wikiHow	staff	writer,	Jack	Lloyd.	Jack	Lloyd	is	a	Technology	Writer	and	Editor	for	wikiHow.	He	has	over	two	years	of	experience	writing	and
editing	technology-related	articles.	He	is	technology	enthusiast	and	an	English	teacher.	This	article	has	been	viewed	714,779	times.	Co-authors:	34	Updated:	August	24,	2023	Views:	714,779	Categories:	Featured	Articles	|	Microsoft	Excel	Print	Send	fan	mail	to	authors	Thanks	to	all	authors	for	creating	a	page	that	has	been	read	714,779	times.	There
are	several	dynamic	ways	to	convert	currency	using	Excel.	Whether	you’re	looking	to	convert	USD	to	EUR	or	any	other	currency	pair,	Excel	provides	powerful	tools	to	help	you	automate	this	process.	We’ll	explore	basic	conversion	methods	and	delve	into	more	advanced	techniques	using	Power	Query.	Specific	Questions	about	Currency	Conversion	If
you	have	specific	questions	about	how	to	convert	currencies	in	Excel,	ask	our	assistant	below.	We	can	give	much	more	specific	feedback	if	you	let	us	know	exactly	what	you’re	trying	to	do.	Note	that	I	also	have	a	guide	on	how	to	convert	currencies	in	Google	Sheets.	Prefer	to	watch	a	video?	I	made	this	one	on	YouTube	that	explains	everything	I	discuss
below.	Converting	currency	in	Excel	is	straightforward	and	efficient.	Whether	you	need	to	convert	USD	to	EUR	or	handle	more	advanced	currency	conversion	tasks,	Excel	offers	several	powerful	tools	to	simplify	the	process.	Convert	USD	to	EUR	Using	Excel’s	Data	Types	Start	with	a	basic	currency	conversion	example:	converting	500	US	dollars
(USD)	to	euros	(EUR).	If	you’re	unsure	about	the	current	exchange	rate,	Excel’s	built-in	Data	Types	feature	is	incredibly	useful.	Follow	these	steps:	Type	the	Currency	Pair:	Enter	the	currency	pair,	USD	EUR,	into	a	cell.	Select	the	Cell:	Highlight	the	cell,	navigate	to	the	Data	menu,	and	choose	Data	Types	>	Currencies.	Automatic	Conversion:	Excel
will	display	the	currency	information	with	a	small	icon	next	to	your	typed	pair.	Clicking	this	icon	reveals	detailed	currency	information.	These	are	explained	in	more	detail	by	Microsoft.	Using	Formulas	for	Currency	Conversion	To	take	advantage	of	Excel’s	currency	conversion	capabilities,	use	formulas:	Reference	Prices	and	Rates:	Click	on	the	cell,
type	=,	and	select	the	function	you	need,	such	as	price.	For	example,	entering	=A1.price	in	another	cell	will	show	the	price	of	USD	in	EUR	directly.	Obviously,	the	easiest	way	to	convert	currencies	is	to	use	simple	math.	You	just	need	to	know	the	exchange	rate.	If	you	have	that,	you	can	use	=Rate*	whatever	cell	you	want	to	convert	to	get	the
converted	amount.	With	either	of	these	methods,	you	can	convert	Indian	Rupees	to	European	Euros	or	American	Dollars	to	Canadian	Dollars.	Advanced	Currency	Conversion	with	Power	Query	For	more	advanced	currency	conversion,	Excel’s	Power	Query	connects	to	web	data	sources	for	real-time	updates.	Here’s	how	to	use	it:	Open	Power	Query:	Go
to	the	Data	menu,	select	Get	Data	>	From	Web,	and	use	available	online	links	to	fetch	real-time	exchange	rates.	Enter	the	URL:	Paste	the	URL	of	the	currency	pair	data	into	the	Power	Query	editor.	Load	Data	into	Excel:	After	fetching	the	data,	load	it	into	an	Excel	sheet	by	choosing	Close	&	Load.	This	method	ensures	your	data	remains	dynamic,
updating	whenever	you	open	the	spreadsheet,	provided	you	have	an	internet	connection.	Handling	Historical	Exchange	Rates	Need	historical	exchange	rates?	Power	Query	simplifies	this	with	its	advanced	options:	Edit	Query	in	Advanced	Editor:	Within	Power	Query,	access	the	Advanced	Editor,	and	adjust	parameters	to	specify	the	required	dates	and
currencies.	Load	and	Refine	Data:	After	adjustments,	load	the	data	into	your	Excel	table	for	precise	historical	data	extraction.	Alternative	Dynamic	Currency	Conversion	Methods	If	Power	Query	seems	complex,	consider	using	Excel’s	web	service	functions	for	dynamic	updates:	Use	Web	Service	Function:	Enter	=WEBSERVICE("URL")	in	a	cell,
replacing	"URL"	with	your	data	source	link.	Dynamic	Updates:	This	method	provides	dynamic	updates	based	on	web	data	without	needing	complex	query	editing.	Other	Currency	Converters	Choosing	the	best	currency	converter	depends	on	your	specific	needs,	whether	you’re	looking	for	real-time	exchange	rates,	historical	data,	or	integration	with
other	tools.	Here’s	a	guide	to	some	of	the	top	currency	converters	available	today:	1.	XE	Currency	Converter	XE	Currency	Converter	is	renowned	for	its	real-time	exchange	rate	updates	and	extensive	coverage	of	global	currencies.	It	offers:	Real-Time	Rates:	XE	provides	accurate	exchange	rates	updated	every	minute.	Currency	Alerts:	Set	up	alerts	for
your	preferred	currency	pairs	to	track	significant	changes.	Mobile	App:	XE’s	user-friendly	app	allows	for	easy	conversion	on	the	go.	2.	OANDA	OANDA	is	a	favorite	among	traders	and	financial	professionals	for	its	comprehensive	data	and	robust	features:	Historical	Data:	Access	historical	exchange	rate	data	going	back	several	decades.	API
Integration:	Perfect	for	businesses	needing	currency	data	integrated	into	their	applications.	Customizable	Rates:	Tailor	exchange	rate	calculations	to	specific	needs	or	conditions.	3.	Google	Currency	Converter	Google’s	built-in	Currency	Converter	is	ideal	for	quick,	straightforward	conversions	directly	from	your	browser:	Instant	Results:	Type	your
query	directly	into	Google’s	search	bar	(e.g.,	500	USD	to	EUR)	for	immediate	results.	Simple	Interface:	Easy	to	use	with	no	additional	features	or	settings	required.	Integration	with	Google	Services:	Access	conversion	information	across	Google	products	and	services	seamlessly.	4.	Wise	(formerly	TransferWise)	Wise	is	highly	regarded	for	its
transparency	and	competitive	exchange	rates,	especially	for	international	transfers:	Mid-Market	Rates:	Wise	offers	exchange	rates	close	to	the	mid-market	rate,	ensuring	fair	pricing.	Low	Fees:	Benefit	from	low	transaction	fees	for	international	transfers.	Multi-Currency	Account:	Manage	multiple	currencies	in	one	account	for	convenience.	5.
CurrencyConverter.io	CurrencyConverter.io	is	another	excellent	choice	for	users	needing	simple	and	accurate	conversions:	Real-Time	Data:	Provides	up-to-date	exchange	rates	for	various	currencies.	Historical	Data:	Includes	historical	exchange	rate	information	for	comparison.	User-Friendly	Interface:	Easy	to	navigate	and	use	for	quick	conversions.
Conclusion	Each	currency	converter	offers	unique	features	tailored	to	different	needs,	from	real-time	updates	to	historical	data	and	low	fees.	Choose	the	one	that	best	fits	your	requirements,	whether	for	casual	use	or	professional	applications.	Excel	offers	a	range	of	methods	for	currency	conversion,	from	straightforward	data	types	to	advanced	Power
Query	options.	Master	these	tools	to	streamline	your	currency	conversion	process	and	maintain	accurate,	up-to-date	financial	data.	Share	—	copy	and	redistribute	the	material	in	any	medium	or	format	for	any	purpose,	even	commercially.	Adapt	—	remix,	transform,	and	build	upon	the	material	for	any	purpose,	even	commercially.	The	licensor	cannot
revoke	these	freedoms	as	long	as	you	follow	the	license	terms.	Attribution	—	You	must	give	appropriate	credit	,	provide	a	link	to	the	license,	and	indicate	if	changes	were	made	.	You	may	do	so	in	any	reasonable	manner,	but	not	in	any	way	that	suggests	the	licensor	endorses	you	or	your	use.	ShareAlike	—	If	you	remix,	transform,	or	build	upon	the
material,	you	must	distribute	your	contributions	under	the	same	license	as	the	original.	No	additional	restrictions	—	You	may	not	apply	legal	terms	or	technological	measures	that	legally	restrict	others	from	doing	anything	the	license	permits.	You	do	not	have	to	comply	with	the	license	for	elements	of	the	material	in	the	public	domain	or	where	your
use	is	permitted	by	an	applicable	exception	or	limitation	.	No	warranties	are	given.	The	license	may	not	give	you	all	of	the	permissions	necessary	for	your	intended	use.	For	example,	other	rights	such	as	publicity,	privacy,	or	moral	rights	may	limit	how	you	use	the	material.	This	tutorial	demonstrates	how	to	create	and	automatic	currency	converter	in
Excel	and	Google	Sheets.	Excel	is	a	powerful	tool	for	calculations,	often	involving	international	currencies.	Excel	does	not	have	a	built-in	currency	conversion	tool,	but	with	a	link	to	an	external	XML	database,	you	can	build	your	own	conversion	tool	into	Excel	using	Power	Query.	Link	to	External	XML	Source	File	The	most	user-friendly	source	file	is
one	called	Floatrates,	a	free	XML	feed	that	is	updated	daily.	In	a	blank	Excel	worksheet,	in	the	Ribbon,	go	to	Data	>	Get	Data	>	From	File	>	From	XML.	In	the	File	name	field,	type	in	the	URL	for	the	Floatrates	file	–	www.floatrates.com/daily.usd.xml	–	and	then	click	Open.	This	opens	the	Power	Query	Editor.	Scroll	across	to	the	last	item	on	the	list,
and	then	click	the	word	Table.	A	table	below	the	initial	line	of	data	is	populated	with	the	exchange	rates.	Click	on	the	double-headed	arrow	to	show	the	fields	of	this	table,	and	then	click	OK.	The	Power	Query	changes	to	show	the	exchange	rate	columns	as	well	as	the	initial	columns.	In	the	Ribbon,	go	to	Home	>	Manage	Columns	>	Choose	Columns.
Uncheck	the	columns	you	don’t	need,	and	then	click	OK.	Click	Close	&	Load	to	return	to	Excel.	Create	Currency	Converter	Create	a	new	worksheet	in	the	same	workbook	as	the	linked	XML	database	and	set	up	a	table	as	shown	below.	Use	the	VLOOKUP	Function	to	look	up	the	currency	rate	for	the	British	Pound	against	the	US	Dollar.	In	the	relevant
cell	(for	example	C5),	type	in:	=VLOOKUP($C$4,	Tip:	Use	an	absolute	reference	($)	so	you	can	copy	the	formula	down.	Then	highlight	the	relevant	lookup	data	by	going	to	the	data	sheet	and	selecting	the	information	you	need.	As	soon	as	you	select	the	entire	data	list,	Excel	automatically	puts	the	columns	of	the	database	as	references	in	the	formula
rather	than	using	the	cell	addresses.	This	is	because	the	table	data	in	Excel	was	linked	into	Excel	with	a	range	name	of	usd.	Complete	the	VLOOKUP	formula	by	typing	in	the	column	name	and	the	word	FALSE	as	the	final	argument	for	the	formula.	=VLOOKUP($C$4,usd[[item.targetCurrency]:[item.exchangeRate]],3,FALSE)	Press	ENTER	to	enter	the
formula	into	Excel.	Repeat	the	procedure	to	look	up	EUR	from	the	data	table.	=VLOOKUP($D$4,usd[[item.targetCurrency]:[item.exchangeRate]],3,FALSE)	To	get	the	value	of	2	USD	to	1	GBP	or	1	EUR,	copy	the	formula	to	the	next	row,	and	then	multiply	it	by	the	value	in	Column	B.	Copy	the	formula	down	to	populate	the	exchange	rate	converter.	To
create	an	exchange	rate	converter	for	the	inverse	rates,	create	another	lookup	–	for	the	inverse	rates	in	the	data.	Automatic	Currency	Conversion	in	Google	Sheets	Google	Sheets	has	a	built-in	currency	converter	that	makes	use	of	existing	up-to-date	conversion	rates	on	the	internet.	Set	up	a	table	in	Google	Sheets	similar	to	the	one	set	up	in	Excel
above.	In	the	selected	cell	(for	example,	C3),	type	in	the	formula	(with	the	GOOGLEFINANCE	Function):	=GOOGLEFINANCE("Currency:"&$B$2&$C$2)	Google	automatically	looks	up	the	exchange	rate	from	USD	(in	B2)	to	GBP	(in	C2)	and	fills	in	the	selected	cell.	Since	cells	B2	and	C2	are	locked	(with	$),	you	can	copy	this	formula	down	to	the	next
cell	and	then	multiply	the	formula	by	the	value	in	Column	B.	=GOOGLEFINANCE("Currency:"&$B$2&$C$2)*B4	Copy	the	formula	in	this	cell	down	to	the	remaining	rows	in	the	conversion	table.	Repeat	the	process	to	look	up	the	EUR.	Other	tutorials	that	use	Power	Query	The	best	way	to	convert	currencies	in	Excel	is	to	automate	the	process	by
creating	a	live	currency	converter.	Since	exchange	rates	are	volatile	and	may	keep	changing	all	the	time,	unless	you	want	static	conversions	at	a	certain	time,	manual	currency	conversion	would	barely	help.	You’d	always	need	to	revisit	the	source	from	where	you’re	getting	the	rates	to	check	for	the	rate	change	and	update	your	data	accordingly	
However,	if	you	follow	the	method	that	I	am	just	going	to	explain	next,	you	can	simply	supply	an	online	web-based	source	of	rates	to	Excel	and	set	up	the	formulas	–	the	rest	Excel	will	see.	Ready?	Let’s	create	a	live	currency	converter	in	Excel.	Here	I	have	a	list	of	items	along	with	their	prices	in	USD.	And	we	need	to	convert	these	prices	from	USD	to
other	Euro	by	creating	a	live	currency	converter.	Here’s	what	we	do:	Step	1)	Go	to	the	Data	tab	>	Get	&	Transform	Data	group	>	From	Web.	This	will	launch	the	From	Web	dialog	box	before	that	looks	like	below		Step	2)	In	this	dialog	box,	in	the	URL	section,	enter	the	following	URL.	Syntax	Highlighter	This	webpage	shows	exchange	rates	for	any
given	currency.	You	can	use	any	other	website	or	external	source	that	you	trust.	This	webpage	looks	like	below.	You	can	select	any	currency	for	which	you	need	the	exchange	rates	by	changing	the	currency	type	from	the	button	highlighted	below.	Like	I	have	selected	USD	since	I	need	the	USD	exchange	rates.	Excel	will	read	the	data	from	this	site
and	present	it	to	you	as	a	query.	Step	3)	Scroll	through	the	tables/panes	on	the	left	to	find	the	exchange	rate	table	imported	from	the	webpage.	I	have	selected	Table	1	which	shows	all	the	exchange	rates	for	USD.	Step	4)	Select	it	and	click	on	the	Load	button.	Excel	will	load	these	rates	to	a	new	sheet	in	Excel	as	here		This	table	is	imported	into	Excel
as	a	query	that	is	still	connected	to	its	external	web	source.	Now	you	can	write	any	formula	in	Excel	using	these	numbers.	For	example,	to	convert	the	USD	prices	to	Euros,	I	have	written	by	following	formula	(directly	using	the	relevant	cell	reference	from	the	sheet	that	contains	rates).	Syntax	Highlighter=B2*'Table	1'!B17Step	5)	Press	enter	to	have
the	price	in	USD	converted	to	Euros.	USD	250	converted	to	233.5	Euros.	However,	before,	we	progress	here	are	two	quick	steps	to	perform.	Step	6)	Convert	the	reference	of	the	exchange	rate	to	an	absolute	reference	by	activating	the	cell,	taking	your	cursor	to	the	relevant	cell	reference,	and	pressing	the	F4	key.	Step	7)	Press	Control	+	1	to	launch
the	Format	Cells	dialog	box.	Step	8)	Go	to	the	Number	tab	>	Currency	from	the	left	pane.	Step	9)	Select	the	currency	symbol	for	the	Euro	and	the	desired	decimal	places.	Step	10)	Now	drag	the	formula	down	the	list	of	all	prices	to	have	all	the	USD	prices	converted	to	Euros.	This	explains	the	basic	method	of	importing	exchange	rates	to	your	Excel
sheet	to	create	a	currency	converter.	Here	onwards,	the	possibilities	are	endless.	You	can	convert	a	single	currency	to	endless	currencies	as	here		Alternatively,	you	can	deploy	the	VLOOKUP	function	for	Excel	to	identify	the	desired	currency	name,	match	it	from	the	list	of	exchange	rates,	and	auto-populate	conversions	for	you.	All	of	these	variations
will	just	keep	going	on.	But	what’s	more	important	is	the	fact	that	how	frequently	are	these	exchange	rates	updated.	You	can	manage	this	part	by	setting	up	the	exact	intervals	when	you	want	Excel	to	automatically	update	the	rates	by	following	these	steps		Step	11)	Select	any	cell	of	the	Exchange	rate	query	table.	Step	12)	Go	to	the	Data	tab	>
Queries	&	Connections	Group	>	Properties.	Step	13)	From	the	dialog	box	that	opens	next,	select	the	small	icon	for	Properties.	This	will	take	you	to	the	query	properties	for	the	exchange	rates	you	imported	in	Excel.	Set	up	whatever	rate	refreshing	interval	you	find	the	best.	Set	it	up	to	be	refreshed	from	the	source	webpage	every	time	the	workbook	is
closed	and	launched	again	or	after	every	certain	minute.	All	up	to	you	�	And	as	the	exchange	rates	in	your	sheet	update,	all	the	formulas	that	use	them	will	also	be	automatically	recalculated	ridding	you	of	the	worries	to	look	out	for	the	latest	exchange	rates	again	and	again.	Makes	it	a	live	currency	calculator	with	current	exchange	rates	within	your
Excel	sheet	–	how	cool	is	that?	Excel	is	not	only	about	what	you	can	see	on	the	Ribbon	before	yourself.	You	can	also	add	much	more	to	it	–	like	Kutools		We	have	a	sample	dataset	where	the		price	of	each	product	is	shown	in	USD,	which	we	want	to	convert	to	EURO.	Steps:	Use	the	following	formula	in	cell	D5:	Here,	cell	G6	is	the	conversion	rate	of
USD	to	EURO.	Drag	the	Fill	handle	icon.	The	price	will	convert	from	USD	to	EURO.	Method	2	–	Utilizing	Nested	IF	Formula	to	Automate	Currency	Conversion	In	the	following	dataset,	we	want	to	convert	USD	to	different	currencies	such	as	EUR,	JPY,	GBP,	CHF,	CAD,	and	AUD.	Steps:	Use	the	following	formula	in	cell	D5:
=IF(C5="eur",0.94,IF(C5="jpy",127.4,IF(C5="gbp",0.8,IF(C5="chf",0.97,IF(C5="cad",1.28,IF(C5="aud",1.41))))))*B5	Drag	the	Fill	handle	icon.	The	amount	will	be	converted	from	USD	to	the	different	currencies	entered.	How	Does	the	Formula	Work?	Here,	we	define	a	condition	whether	cell	C5	is	equal	to		EUR,	JPY,	GBP,	CHF,	CAD,	or	AUD.	Once
this	condition	is	met,	the	function	will	return	a	value	and	the	value	will	be	multiplied	by	cell	B5.	Method	3	–	Using	VLOOKUP	Function	to	Automate	Currency	Conversion	Steps:	Use	the	following	formula	in	the	cell	D5:	=B5*VLOOKUP(C5,$F$5:$G$10,2,0)	Drag	the	Fill	handle	icon.	The	amount	will	be	converted	from	USD	to	the	different	currencies
entered.	How	Does	the	Formula	Work?	The	VLOOKUP	function	looks	for	a	value	in	the	table	array	F5:G10	and	then	returns	a	value	in	the	row	from	the	column	we	specify.	The	returned	value	is	multiplied	by	cell	B5	to	give	the	converted	amounts	for	each	currency.	Method	4	–	Combination	of	INDEX	and	MATCH	Functions	in	Excel	Steps:	Use	the
following	formula	in	cell	D5:	=INDEX($G$5:$G$10,	MATCH(C5,$F$5:$F$10,0))*B5	Drag	the	Fill	handle	icon.	The	amount	will	be	converted	from	USD	to	the	different	currencies	entered.	How	Does	the	Formula	Work?	The	MATCH(C5,$F$5:$F$10,0)	function	returns	the	relative	position	of	an	item	in	the	array	F5:F10	that	matches	a	specified	value	C5
in	the	specified	order.	The	INDEX	function	returns	the	0.94	which	is	in	the	first	row	of	the	range	F5:F10.	Multiply	the	whole	combined	functions	by	cell	B5	to	get	the	final	output.	Method	5	–	Using	External	XML	Source	in	Excel	Steps:	Go	to	the	Data	tab,	select	Get	Data	>	From	File	>	From	XML.	When	the	Import	Data	window	appears,	enter	the	URL:
in	the	File	name.	Then,	click	on	Import.	When	the	Power	Query	Editor	opens,	go	to	the	Item.	Click	on	Table.	Click	on	the	arrow.	You	will	get	the	exchange	rate	columns.	Select	Home	>	Manage	Columns	>	Choose	Columns.	Check	the	required	columns	like	the	following	and	click	on	OK.	You	will	get	the	exchange	rate	in	the	spreadsheet.	Now,	you	have
to	create	a	new	worksheet	Use	the	following	formula	in	the	cell	C5:	=VLOOKUP($C$4,usd[[item.targetCurrency]:[item.exchangeRate]],3,FALSE)	Here,	C4	is	the	GBP	currency	and	the	final	argument	is	False.	The	[[item.targetCurrency]:[item.exchangeRate]]	is	the	lookup	data	in	the	linked	XML	file.	Use	the	following	formula	in	cell	C6:
=VLOOKUP($C$4,usd[[item.targetCurrency]:[item.exchangeRate]],3,FALSE)*B6	Here,	C4	is	the	GBP	currency	and	the	final	argument	is	False.	The	whole	formula	is	multiplied	by	cell	B6	to	get	the	converted	currency.	Drag	the	Fill	handle	icon.	It	will	convert	USD	TO	GBP.	Use	the	following	formula	in	the	cell	D5:
=VLOOKUP($D$4,usd[[item.targetCurrency]:[item.exchangeRate]],3,FALSE)	Here,	D4	is	the	EUR	currency	and	the	final	argument	is	False.	The	[[item.targetCurrency]:[item.exchangeRate]]	is	the	lookup	data	in	the	linked	XML	file.	Use	the	following	formula	in	the	cell	D6:	=VLOOKUP($D$4,usd[[item.targetCurrency]:
[item.exchangeRate]],3,FALSE)*B6	Here,	C4	is	the	GBP	currency	and	the	final	argument	is	False.	The	whole	formula	is	multiplied	by	cell	B6	to	get	the	converted	currency.	Drag	the	Fill	handle	icon.	It	will	convert	USD	to	different	currencies.	Download	Practice	Workbook	Automate	Currency	Conversion.xlsx	=	0	And	y	>=	0	Then	'	Perform	conversion
and	update	TextBox2	TextBox2.Value	=	TextBox1.Value	*	ex_rates(x)(y)	End	If	End	Sub	Assign	the	associated	code	to	the	UserForm_Initialize	section	of	the	same	window.	Private	Sub	UserForm_Initialize()	With	ListBox1	.AddItem	"Euro"	.AddItem	"Us	Dollar"	.AddItem	"British	Pound"	.AddItem	"Japanese	Yen"	End	With	With	ListBox2	.AddItem	"Euro"
.AddItem	"Us	Dollar"	.AddItem	"British	Pound"	.AddItem	"Japanese	Yen"	End	With	TextBox1.Value	=	"Enter	Input"	TextBox2.Value	=	"Output"	End	Sub	Assign	the	following	codes	in	the	same	code	window	to	make	the	ListBoxes	and	TextBox1	dynamic.	Private	Sub	TextBox1_Change()	TextBox2.Text	=	""	End	Sub	Private	Sub	ListBox2_Change()
TextBox2.Text	=	""	End	Sub	Private	Sub	ListBox1_Change()	TextBox2.Text	=	""	End	Sub	Add	the	following	code	in	the	same	window.	Private	Sub	TextBox1_Enter()	'This	code	runs	when	the	user	clicks	on	TextBox1	'Check	if	the	current	text	is	"Enter	Amount"	If	TextBox1.Value	=	"Enter	Input"	Then	'Clear	the	text	and	make	it	a	null	textbox
TextBox1.Value	=	""	TextBox2.Value	=	""	End	If	End	Sub	Our	UserForm	is	ready	to	use	now.	We	will	insert	a	button	in	the	worksheet.	Go	to	Developer	and	select	Insert,	then	choose	Button	(under	Form	Controls).	To	assign	a	Macro	to	the	button,	right-click	on	the	button,	select	Assign	Macro,	and	paste	the	following	code.	Sub	Button1_Click()
UserForm1.Show	End	Sub	Click	on	the	button	and	you’ll	get	a	UserForm	as	a	calculator.	How	to	Change	the	Default	Currency	in	Excel?	The	following	image	shows	a	currency	amount	in	cell	G7.	Excel	has	automatically	considered	it	to	be	USD.	But,	we	want	it	to	change	it	to	INR.	Steps:	Select	the	cell	G7.	Click	Number	group	in	Home	tab.	Click	the
Number	Format	symbol.	This	will	open	the	Format	Cells	dialog	box.	Select	Number	then	Currency.	Select	the	desired	currency	from	the	Symbol:	drop-down	menu.	Click	OK.	The	currency	symbol	has	been	changed	to	INR.	Read	More:	How	to	Change	Default	Currency	in	Excel	Download	the	Practice	Workbook	Currency	Conversion.xlsm	Spreadsheet
editor,	part	of	Microsoft	365	"Excel"	redirects	here.	For	other	uses,	see	Excel	(disambiguation).	Microsoft	ExcelA	simple	bar	graph	being	created	in	Excel,	running	on	Windows	11Developer(s)MicrosoftInitial	releaseSeptember	30,	1985;	39	years	ago	(1985-09-30)Stable	release(s)	Latest	versions	(365	and	Office)	Microsoft	365	&	Retail[a]
(Windows)2505	(Build	18827.20150)	/	10	June	2025;	44	days	ago	(2025-06-10)[1][2][3][4]Microsoft	365	(Mac)16.98.0	(Build	25060824)	/	10	June	2025;	44	days	ago	(2025-06-10)[5]Office	2024	(LTSC)2408	(Build	17932.20396)	/	10	June	2025;	44	days	ago	(2025-06-10)[2]Office	2021	(LTSC)2108	(Build	14334.20090)	/	10	June	2025;	44	days	ago	(2025-
06-10)[3]Office	2019	(LTSC)1808	(Build	10417.20020)	/	10	June	2025;	44	days	ago	(2025-06-10)[4]	Latest	versions	(standalone	app)	WindowsJuly	2025	Update	(19.2507.51101.0)	/	24	July	2025;	0	days	ago	(2025-07-24)[6]Android16.0	(Build	19029.20080)	/	20	July	2025;	4	days	ago	(2025-07-20)[7][8]iOS2.99.1	/	18	July	2025;	6	days	ago	(2025-07-18)[9]
Written	inC++	(back-end)[10]Operating	systemMicrosoft	WindowsTypeSpreadsheetLicenseTrialware[11]	or	Proprietary	commercial	softwareWebsitemicrosoft.com/en-us/microsoft-365/excel	Microsoft	Excel	is	a	spreadsheet	editor	developed	by	Microsoft	for	Windows,	macOS,	Android,	iOS	and	iPadOS.	It	features	calculation	or	computation
capabilities,	graphing	tools,	pivot	tables,	and	a	macro	programming	language	called	Visual	Basic	for	Applications	(VBA).	Excel	forms	part	of	the	Microsoft	365	and	Microsoft	Office	suites	of	software	and	has	been	developed	since	1985.	Logo	from	2013	to	2019	Logo	from	2007	to	2010	Main	article:	Spreadsheet	Microsoft	Excel	has	the	basic	features	of
all	spreadsheets,[12]	using	a	grid	of	cells	arranged	in	numbered	rows	and	letter-named	columns	to	organize	data	manipulations	like	arithmetic	operations.	It	has	a	battery	of	supplied	functions	to	answer	statistical,	engineering,	and	financial	needs.	In	addition,	it	can	display	data	as	line	graphs,	histograms	and	charts,	and	with	a	very	limited	three-
dimensional	graphical	display.	It	allows	sectioning	of	data	to	view	its	dependencies	on	various	factors	for	different	perspectives	(using	pivot	tables	and	the	scenario	manager).[13]	A	PivotTable	is	a	tool	for	data	analysis.	It	does	this	by	simplifying	large	data	sets	via	PivotTable	fields.	It	has	a	programming	aspect,	Visual	Basic	for	Applications,	allowing
the	user	to	employ	a	wide	variety	of	numerical	methods,	for	example,	for	solving	differential	equations	of	mathematical	physics,[14][15]	and	then	reporting	the	results	back	to	the	spreadsheet.	It	also	has	a	variety	of	interactive	features	allowing	user	interfaces	that	can	completely	hide	the	spreadsheet	from	the	user,	so	the	spreadsheet	presents	itself
as	a	so-called	application,	or	decision	support	system	(DSS),	via	a	custom-designed	user	interface,	for	example,	a	stock	analyzer,[16]	or	in	general,	as	a	design	tool	that	asks	the	user	questions	and	provides	answers	and	reports.[17][18]	In	a	more	elaborate	realization,	an	Excel	application	can	automatically	poll	external	databases	and	measuring
instruments	using	an	update	schedule,[19]	analyze	the	results,	make	a	Word	report	or	PowerPoint	slide	show,	and	e-mail	these	presentations	on	a	regular	basis	to	a	list	of	participants.	Microsoft	allows	for	a	number	of	optional	command-line	switches	to	control	the	manner	in	which	Excel	starts.[20]	See	also:	Microsoft	Power	Fx	Excel	2016	has	484
functions.[21]	Of	these,	360	existed	prior	to	Excel	2010.	Microsoft	classifies	these	functions	into	14	categories.	Of	the	484	current	functions,	386	may	be	called	from	VBA	as	methods	of	the	object	"WorksheetFunction"[22]	and	44	have	the	same	names	as	VBA	functions.[23]	With	the	introduction	of	LAMBDA,	Excel	became	Turing	complete.[24]	Main
article:	Visual	Basic	for	Applications	Use	of	a	user-defined	function	sq(x)	in	Microsoft	Excel.	The	named	variables	x	&	y	are	identified	in	the	Name	Manager.	The	function	sq	is	introduced	using	the	Visual	Basic	editor	supplied	with	Excel.	Subroutine	in	Excel	calculates	the	square	of	named	column	variable	x	read	from	the	spreadsheet,	and	writes	it	into
the	named	column	variable	y.	The	Windows	version	of	Excel	supports	programming	through	Microsoft's	Visual	Basic	for	Applications	(VBA),	which	is	a	dialect	of	Visual	Basic.	Programming	with	VBA	allows	spreadsheet	manipulation	that	is	awkward	or	impossible	with	standard	spreadsheet	techniques.	Programmers	may	write	code	directly	using	the
Visual	Basic	Editor	(VBE),	which	includes	a	window	for	writing	code,	debugging	code,	and	code	module	organization	environment.	The	user	can	implement	numerical	methods	as	well	as	automating	tasks	such	as	formatting	or	data	organization	in	VBA[25]	and	guide	the	calculation	using	any	desired	intermediate	results	reported	back	to	the
spreadsheet.	VBA	was	removed	from	Mac	Excel	2008,	as	the	developers	did	not	believe	that	a	timely	release	would	allow	porting	the	VBA	engine	natively	to	Mac	OS	X.	VBA	was	restored	in	the	next	version,	Mac	Excel	2011,[26]	although	the	build	lacks	support	for	ActiveX	objects,	impacting	some	high	level	developer	tools.[27]	A	common	and	easy	way
to	generate	VBA	code	is	by	using	the	Macro	Recorder.[28]	The	Macro	Recorder	records	actions	of	the	user	and	generates	VBA	code	in	the	form	of	a	macro.	These	actions	can	then	be	repeated	automatically	by	running	the	macro.	The	macros	can	also	be	linked	to	different	trigger	types	like	keyboard	shortcuts,	a	command	button	or	a	graphic.	The
actions	in	the	macro	can	be	executed	from	these	trigger	types	or	from	the	generic	toolbar	options.	The	VBA	code	of	the	macro	can	also	be	edited	in	the	VBE.	Certain	features	such	as	loop	functions	and	screen	prompt	by	their	own	properties,	and	some	graphical	display	items,	cannot	be	recorded	but	must	be	entered	into	the	VBA	module	directly	by	the
programmer.	Advanced	users	can	employ	user	prompts	to	create	an	interactive	program,	or	react	to	events	such	as	sheets	being	loaded	or	changed.	Macro	Recorded	code	may	not	be	compatible	with	Excel	versions.	Some	code	that	is	used	in	Excel	2010	cannot	be	used	in	Excel	2003.	Making	a	Macro	that	changes	the	cell	colors	and	making	changes	to
other	aspects	of	cells	may	not	be	backward	compatible.	VBA	code	interacts	with	the	spreadsheet	through	the	Excel	Object	Model,[29]	a	vocabulary	identifying	spreadsheet	objects,	and	a	set	of	supplied	functions	or	methods	that	enable	reading	and	writing	to	the	spreadsheet	and	interaction	with	its	users	(for	example,	through	custom	toolbars	or
command	bars	and	message	boxes).	User-created	VBA	subroutines	execute	these	actions	and	operate	like	macros	generated	using	the	macro	recorder,	but	are	more	flexible	and	efficient.	From	its	first	version	Excel	supported	end-user	programming	of	macros	(automation	of	repetitive	tasks)	and	user-defined	functions	(extension	of	Excel's	built-in
function	library).	In	early	versions	of	Excel,	these	programs	were	written	in	a	macro	language	whose	statements	had	formula	syntax	and	resided	in	the	cells	of	special-purpose	macro	sheets	(stored	with	file	extension	.XLM	in	Windows.)	XLM	was	the	default	macro	language	for	Excel	through	Excel	4.0.[30]	Beginning	with	version	5.0	Excel	recorded
macros	in	VBA	by	default	but	with	version	5.0	XLM	recording	was	still	allowed	as	an	option.	After	version	5.0	that	option	was	discontinued.	All	versions	of	Excel,	including	Excel	2021,	are	capable	of	running	an	XLM	macro,	though	Microsoft	discourages	their	use.[31]	In	2023,	Microsoft	announced	Excel	would	support	the	Python	programming
language	directly.[32][33]	As	of	2025,	Python	in	Excel	is	available	in	to	Enterprise	and	Business	users	(with	some	exceptions,	and	is	in	preview	for	Family,	Personal,	and	Education	users).[34][32]	Graph	made	using	Microsoft	Excel	Excel	supports	charts,	graphs,	or	histograms	generated	from	specified	groups	of	cells.	It	also	supports	Pivot	Charts	that
allow	for	a	chart	to	be	linked	directly	to	a	Pivot	table.	This	allows	the	chart	to	be	refreshed	with	the	Pivot	Table.	The	generated	graphic	component	can	either	be	embedded	within	the	current	sheet	or	added	as	a	separate	object.	These	displays	are	dynamically	updated	if	the	content	of	cells	changes.	For	example,	suppose	that	the	important	design
requirements	are	displayed	visually;	then,	in	response	to	a	user's	change	in	trial	values	for	parameters,	the	curves	describing	the	design	change	shape,	and	their	points	of	intersection	shift,	assisting	the	selection	of	the	best	design.	Additional	features	are	available	using	add-ins.	Several	are	provided	with	Excel,	including:	Analysis	ToolPak:	Provides
data	analysis	tools	for	statistical	and	engineering	analysis	(includes	analysis	of	variance	and	regression	analysis)	Analysis	ToolPak	VBA:	VBA	functions	for	Analysis	ToolPak	Euro	Currency	Tools:	Conversion	and	formatting	for	euro	currency	Solver	Add-In:	Tools	for	optimization	and	equation	solving	Versions	of	Excel	up	to	7.0	had	a	limitation	in	the	size
of	their	data	sets	of	16K	(214	=	16384)	rows.	Versions	8.0	through	11.0	could	handle	64K	(216	=	65536)	rows	and	256	columns	(28	as	label	'IV').	Version	12.0	onwards,	including	the	current	Version	16.x,	can	handle	over	1M	(220	=	1048576)	rows,	and	16384	(214,	labeled	as	column	'XFD')	columns.[35]	Excel	SpreadsheetFilename	extension	.xls,
(.xlsx,	.xlsm,	.xlsb	–	Excel	2007)Internet	media	type	application/vnd.ms-excelUniform	Type	Identifier	(UTI)com.microsoft.excel.xlsDeveloped	byMicrosoftType	of	formatSpreadsheet	Up	until	the	2007	version,	Microsoft	Excel	used	a	proprietary	binary	file	format	called	Excel	Binary	File	Format	(.XLS)	as	its	primary	format.[36]	Excel	2007	uses	Office
Open	XML	as	its	primary	file	format,	an	XML-based	format	that	followed	after	a	previous	XML-based	format	called	"XML	Spreadsheet"	("XMLSS"),	first	introduced	in	Excel	2002.[37]	Although	supporting	and	encouraging	the	use	of	new	XML-based	formats	as	replacements,	Excel	2007	remained	backwards-compatible	with	the	traditional,	binary
formats.	In	addition,	most	versions	of	Microsoft	Excel	can	read	CSV,	DBF,	SYLK,	DIF,	and	other	legacy	formats.	Support	for	some	older	file	formats	was	removed	in	Excel	2007.[38]	The	file	formats	were	mainly	from	DOS-based	programs.	OpenOffice.org	has	created	documentation	of	the	Excel	format.	Two	epochs	of	the	format	exist:	the	97-2003	OLE
format,	and	the	older	stream	format.[39]	Microsoft	has	made	the	Excel	binary	format	specification	available	to	freely	download.[40]	Main	article:	Microsoft	Office	XML	formats	The	XML	Spreadsheet	format	introduced	in	Excel	2002[37]	is	a	simple,	XML	based	format	missing	some	more	advanced	features	like	storage	of	VBA	macros.	Though	the
intended	file	extension	for	this	format	is	.xml,	the	program	also	correctly	handles	XML	files	with	.xls	extension.	This	feature	is	widely	used	by	third-party	applications	(e.g.	MySQL	Query	Browser)	to	offer	"export	to	Excel"	capabilities	without	implementing	binary	file	format.	The	following	example	will	be	correctly	opened	by	Excel	if	saved	either	as
Book1.xml	or	Book1.xls:	Table.With	the	cells	still	selected,	go	to	the	Data	tab	and	choose	the	Currencies	data	type.If	Excel	finds	a	match,	it	will	convert	the	text	into	a	data	type	and	display	a	currency	icon.To	extract	more	details,	select	the	converted	cells	and	click	the	Insert	Data	button.This	setup	allows	you	to	create	a	dynamic	table	that	updates
automatically	with	real-time	exchange	rates.	It’s	an	efficient	way	to	manage	currency	conversion	for	financial	analysis	or	business	operations.Refreshing	data	for	updated	ratesTo	keep	your	exchange	rates	current,	refresh	the	data	regularly.	Right-click	on	the	table	and	select	Refresh.	This	action	ensures	your	calculations	always	reflect	the	latest
market	values.	Automating	this	process	can	save	time	and	reduce	manual	effort.	Tip:	Use	this	method	to	streamline	your	workflow	and	maintain	accurate	financial	records.Automating	Currency	Updates	in	ExcelKeeping	exchange	rates	updated	manually	can	be	time-consuming	and	prone	to	errors.	Automating	currency	updates	in	Microsoft	Excel
ensures	your	data	remains	accurate	and	saves	you	valuable	time.	Let’s	explore	how	you	can	refresh	data	manually,	set	up	automatic	updates,	and	create	a	fully	automated	currency	conversion	dashboard.Manual	Refresh	MethodsRefreshing	linked	data	manuallyYou	can	refresh	linked	data	manually	in	Excel	to	ensure	your	currency	conversion
calculations	use	the	latest	exchange	rates.	Follow	these	steps:Select	a	cell	in	the	range	or	table	containing	the	linked	data.Go	to	the	Data	tab	and	click	Refresh	All	in	the	Connections	group.To	refresh	specific	data,	right-click	a	cell	in	the	table	and	select	Refresh.Manual	refreshes	are	useful	for	tasks	like	sales	reports,	inventory	management,	and
financial	analysis.	They	allow	you	to	control	when	updates	occur,	ensuring	your	data	reflects	the	latest	information	without	unnecessary	changes.Troubleshooting	common	refresh	issuesSometimes,	linked	data	may	not	refresh	as	expected.	Common	issues	include	broken	connections	or	outdated	links.	To	resolve	these	problems:Verify	the	data	source
is	accessible	and	active.Check	the	connection	settings	in	the	Queries	&	Connections	pane.Re-establish	the	link	by	re-importing	the	data	if	necessary.	Tip:	Use	the	Power	Query	Editor	to	inspect	and	modify	your	data	connections.	This	tool	helps	you	identify	and	fix	errors	efficiently.Automatic	Refresh	SetupConfiguring	Excel	to	auto-refresh
dataAutomating	data	refreshes	ensures	your	currency	conversion	tools	always	use	current	exchange	rates.	To	set	this	up:Open	the	Queries	&	Connections	pane.Right-click	a	query	and	select	Properties.Check	the	box	for	Refresh	data	when	opening	the	file.For	scheduled	refreshes,	set	a	refresh	frequency	in	the	query	properties.This	setup	is
particularly	beneficial	for	businesses	dealing	with	frequent	currency	fluctuations.	It	eliminates	the	need	for	manual	updates,	keeping	your	data	accurate	and	reliable.Using	VBA	macros	for	advanced	automationFor	more	advanced	automation,	you	can	use	VBA	macros.	Write	a	macro	to	refresh	all	data	connections	automatically.	Here’s	an	example
code	snippet:Sub	AutoRefresh()				ThisWorkbook.RefreshAllEnd	SubRun	this	macro	to	refresh	your	workbook’s	data	instantly.	You	can	also	schedule	the	macro	to	run	at	specific	intervals	using	the	Application.OnTime	method.	This	approach	is	ideal	for	large	datasets	or	complex	financial	models.⚠		Note:	Always	test	your	macros	in	a	backup	file	to	avoid
unintended	changes.Example:	Automating	a	Currency	Conversion	DashboardStep-by-step	guide	to	create	a	dashboardAn	automated	currency	conversion	dashboard	streamlines	your	workflow.	Follow	these	steps	to	build	one:Import	live	exchange	rate	data	using	Power	Query	or	the	Currency	data	type.Create	a	table	for	input	values,	exchange	rates,
and	converted	amounts.Use	formulas	like	=Amount	*	ExchangeRate	to	calculate	conversions	dynamically.Add	slicers	or	dropdown	menus	for	selecting	currencies.Set	up	automatic	refreshes	for	real-time	updates.This	dashboard	provides	a	centralized	view	of	your	currency	data,	making	it	easier	to	analyze	trends	and	make	informed	decisions.Tips	for
maintaining	accuracy	and	performanceTo	ensure	your	dashboard	remains	accurate:Regularly	verify	the	data	source	for	reliability.Optimize	formulas	to	reduce	calculation	time.Use	conditional	formatting	to	highlight	discrepancies	or	trends.Automating	your	dashboard	not	only	saves	time	but	also	reduces	the	risk	of	errors.	It	ensures	your	currency
conversion	tools	always	deliver	precise	results.	Tip:	Use	Excel’s	built-in	features	like	pivot	tables	and	charts	to	enhance	your	dashboard’s	functionality	and	visual	appeal.Formatting	and	Customizing	Currency	Conversion	ResultsFormatting	your	currency	conversion	results	properly	in	Microsoft	Excel	ensures	clarity	and	professionalism.	By	applying
consistent	currency	formatting	and	using	visual	tools	like	conditional	formatting,	you	can	make	your	data	easier	to	interpret.	Let’s	explore	how	to	format	and	customize	your	results	effectively.Applying	Currency	FormattingUsing	Excel’s	built-in	currency	formatsExcel	provides	built-in	currency	formatting	options	that	simplify	the	process	of	displaying
monetary	values.	To	apply	these	formats:Select	the	cells	containing	your	currency	conversion	results.Navigate	to	the	Home	tab	and	click	the	Number	Format	dropdown.Choose	a	currency	format,	such	as	USD	($)	or	EUR	(€).This	method	automatically	applies	the	correct	currency	symbol	and	decimal	places,	ensuring	your	data	looks	professional.	Built-
in	formats	also	help	maintain	consistency	across	your	spreadsheet,	which	is	essential	for	clear	communication.Customizing	currency	symbols	and	decimal	placesSometimes,	you	may	need	to	customize	currency	symbols	or	adjust	decimal	places	for	specific	requirements.	To	do	this:Right-click	the	selected	cells	and	choose	Format	Cells.In	the	Format
Cells	dialog	box,	select	Currency	or	Custom.Modify	the	symbol,	decimal	places,	or	even	add	text	for	unique	formatting	needs.For	example,	you	can	display	amounts	in	thousands	by	using	a	custom	format	like	#,##0.00,"K".	This	approach	is	particularly	useful	for	summarizing	large	datasets	in	financial	reports.	Tip:	Use	consistent	data	formats
throughout	your	workbook.	Standardizing	your	currency	codes	and	number	formats	improves	readability	and	reduces	errors.Conditional	Formatting	for	Currency	ValuesHighlighting	specific	currencies	or	thresholdsConditional	formatting	allows	you	to	emphasize	important	data	points	in	your	currency	conversion	results.	For	instance,	you
can:Highlight	cells	with	specific	currencies	using	color	fills.Apply	rules	to	flag	values	above	or	below	a	certain	threshold.Use	icon	sets,	such	as	arrows,	to	indicate	trends	in	exchange	rates.These	visual	cues	make	it	easier	to	identify	key	insights	at	a	glance,	especially	when	working	with	large	datasets.Example:	Visualizing	currency	trends	with	color
scalesColor	scales	are	a	powerful	tool	for	visualizing	trends	in	currency	values.	To	apply	them:Select	the	range	of	cells	containing	your	data.Go	to	the	Home	tab	and	click	Conditional	Formatting.Choose	Color	Scales	and	select	a	gradient,	such	as	red	for	low	values	and	green	for	high	values.This	technique	helps	you	track	fluctuations	in	exchange	rates
or	identify	outliers	in	your	data.	Data	bars	can	also	provide	a	quick	visual	comparison	of	values,	aiding	in	budget	tracking	or	expense	management.⚠		Note:	Always	verify	your	conditional	formatting	rules	to	ensure	they	align	with	your	analysis	goals.Example:	Creating	a	Professional	Currency	ReportStep-by-step	guide	to	format	and	present	dataA	well-
designed	currency	report	enhances	your	ability	to	communicate	financial	insights.	Follow	these	steps	to	create	one:Organize	your	data	by	separating	raw	inputs,	calculations,	and	results	into	different	sheets.Apply	consistent	currency	formatting	to	all	monetary	values.Use	named	ranges	for	exchange	rate	tables	to	simplify	your	formulas.Add
conditional	formatting	to	highlight	trends	or	anomalies.Summarize	your	data	using	pivot	tables	for	a	clear	overview.For	example,	you	can	create	a	table	that	shows	converted	amounts	for	multiple	currencies	alongside	their	exchange	rates.	Use	slicers	or	filters	to	allow	users	to	interact	with	the	data	dynamically.Tips	for	improving	readability	and
aestheticsTo	make	your	report	more	visually	appealing:Use	charts	or	graphs	to	represent	trends	in	currency	conversion	results.Apply	a	clean,	professional	font	and	avoid	excessive	colors.Include	a	legend	or	notes	to	explain	any	custom	formatting	or	calculations.By	following	these	practices,	you	can	create	a	report	that	is	both	informative	and	visually
engaging.	This	approach	ensures	your	audience	can	easily	understand	and	act	on	the	data.	Tip:	Document	your	sources	and	update	your	exchange	rates	regularly	to	maintain	accuracy	in	your	reports.PageOn.ai:	Your	Perfect	Presentation	and	Data	Analysis	ToolCombining	AI	search	and	virtual	presentation	featuresPageOn.ai	revolutionizes	how	you
create	presentations	by	combining	advanced	AI	search	capabilities	with	virtual	presentation	tools.	It	allows	you	to	generate	professional	slides	quickly	using	the	information	you	provide.	The	platform’s	AI-powered	SearchGPT	retrieves	extensive	data,	saving	you	time	and	effort	in	gathering	relevant	information.	It	also	analyzes	your	search	habits	to
optimize	content,	ensuring	your	presentations	align	with	audience	interests.PageOn.ai	doesn’t	stop	there.	It	identifies	effective	keywords	and	analyzes	their	relevance,	helping	you	craft	presentations	that	resonate	with	your	audience.	You	can	even	incorporate	current	market	trends	into	your	slides,	thanks	to	its	trend	analysis	feature.	Personalized
customization	options	let	you	tailor	templates	to	match	your	preferences,	making	your	presentations	unique	and	impactful.Generating	impactful	presentations	with	minimal	effortCreating	a	compelling	presentation	often	feels	overwhelming,	but	PageOn.ai	simplifies	the	process.	Its	AI	tools	streamline	every	step,	from	data	collection	to	slide	design.
You	can	focus	on	your	message	while	the	platform	handles	the	technical	details.	Whether	you	need	a	detailed	financial	report	or	a	visually	engaging	summary,	PageOn.ai	ensures	your	presentation	stands	out.	Tip:	Use	PageOn.ai’s	keyword	optimization	feature	to	make	your	content	more	engaging	and	relevant	to	your	audience.Key	Features	of
PageOn.aiData	analysis	and	report	generationPageOn.ai	excels	in	data	analysis,	making	it	an	invaluable	tool	for	creating	currency	conversion	reports.	It	processes	complex	datasets	efficiently,	providing	insights	that	enhance	your	decision-making.	The	platform	generates	detailed	reports	that	are	easy	to	understand,	even	for	those	unfamiliar	with
financial	jargon.	This	feature	is	particularly	useful	when	you	need	to	present	data	to	stakeholders	or	clients.AI-generated	images	for	presentationsVisuals	play	a	crucial	role	in	making	presentations	memorable.	PageOn.ai	offers	AI-generated	images	that	complement	your	content	perfectly.	These	images	are	tailored	to	your	topic,	ensuring	they
enhance	your	message	rather	than	distract	from	it.	By	incorporating	relevant	visuals,	you	can	make	your	presentations	more	engaging	and	professional.⚠		Note:	Always	review	the	generated	images	to	ensure	they	align	with	your	presentation’s	tone	and	purpose.How	to	Use	PageOn.ai	for	Currency	Conversion	ReportsStep-by-step	guide	to	create	a
presentationStart	by	uploading	your	currency	conversion	data	to	PageOn.ai.Use	the	platform’s	AI	tools	to	analyze	the	data	and	identify	key	insights.Select	a	presentation	template	that	suits	your	needs.Customize	the	slides	by	adding	charts,	tables,	and	visuals	generated	by	the	AI.Review	the	final	presentation	to	ensure	accuracy	and	clarity.This
process	allows	you	to	create	a	polished	presentation	in	minutes,	saving	you	time	and	effort.Customizing	templates,	charts,	and	imagesPageOn.ai	offers	a	wide	range	of	customization	options	to	help	you	create	a	unique	presentation.	You	can	modify	templates	to	match	your	branding,	adjust	chart	styles	to	highlight	specific	data	points,	and	replace
default	images	with	AI-generated	visuals.	These	features	give	you	complete	control	over	the	look	and	feel	of	your	presentation.	Tip:	Experiment	with	different	templates	and	chart	styles	to	find	the	best	way	to	present	your	data	effectively.Benefits	of	Using	PageOn.aiEnhancing	collaboration	with	cloud	storagePageOn.ai	makes	teamwork	seamless	by
integrating	cloud	storage	into	its	platform.	You	can	upload	your	currency	conversion	data	and	share	it	with	your	team	instantly.	This	feature	ensures	everyone	works	on	the	same	version	of	the	file,	reducing	confusion	caused	by	outdated	documents.Cloud	storage	allows	you	to	access	your	files	from	any	device	with	an	internet	connection.	Whether	you
are	in	the	office	or	working	remotely,	you	can	retrieve	your	data	without	hassle.	This	flexibility	ensures	you	stay	productive	no	matter	where	you	are.	Tip:	Use	the	platform’s	permission	settings	to	control	who	can	view	or	edit	your	files.	This	ensures	sensitive	financial	data	remains	secure.Collaboration	becomes	even	easier	with	real-time	updates.
When	you	or	your	team	members	make	changes,	the	platform	syncs	them	automatically.	This	eliminates	the	need	to	send	multiple	email	attachments	or	worry	about	version	control.	You	can	focus	on	analyzing	data	and	creating	impactful	presentations	instead	of	managing	files.⚠		Note:	Always	back	up	critical	files	to	avoid	losing	important	data	during
unexpected	technical	issues.Saving	time	with	automated	toolsPageOn.ai’s	automated	tools	simplify	complex	tasks,	saving	you	valuable	time.	Instead	of	manually	formatting	your	currency	conversion	reports,	you	can	use	the	platform’s	AI-powered	features	to	generate	professional	slides	in	minutes.	This	efficiency	allows	you	to	focus	on	interpreting	the
data	rather	than	preparing	it.The	platform	also	automates	repetitive	tasks	like	creating	charts	or	summarizing	data.	For	example,	you	can	upload	your	spreadsheet,	and	the	AI	will	instantly	generate	visuals	that	highlight	key	trends.	This	feature	is	especially	useful	when	you	need	to	present	data	to	stakeholders	quickly.	Tip:	Experiment	with	the
platform’s	templates	to	find	one	that	best	suits	your	presentation	style.Automation	reduces	the	risk	of	human	error.	By	letting	the	AI	handle	calculations	and	formatting,	you	can	ensure	your	reports	are	accurate	and	consistent.	This	reliability	builds	trust	with	your	audience	and	enhances	your	professional	reputation.⚠		Note:	Review	the	AI-generated
content	to	ensure	it	aligns	with	your	specific	requirements.With	PageOn.ai,	you	can	streamline	your	workflow	and	achieve	more	in	less	time.	Its	tools	empower	you	to	create	polished	presentations	effortlessly,	making	it	an	essential	resource	for	anyone	managing	financial	data.Advanced	Techniques	for	Currency	ConversionUsing	APIs	for	Real-Time
DataConnecting	to	a	currency	exchange	APIAPIs	provide	a	reliable	way	to	fetch	real-time	exchange	rates	for	currency	conversion.	You	can	connect	to	an	API	by	creating	a	web	query	in	Microsoft	Excel.	Start	by	selecting	the	Data	tab	and	choosing	the	"From	Web"	option.	Enter	the	API	URL,	such	as	into	the	query	field.	If	you	need	to	change	the	base
currency,	modify	the	URL	to	include	the	desired	currency,	like	.	Once	you	run	the	query,	Excel	will	retrieve	the	latest	exchange	rates	and	load	them	into	your	spreadsheet.	This	method	ensures	your	data	remains	accurate	and	up-to-date.Importing	data	into	Excel	with	Power	Query	or	VBAYou	can	use	Power	Query	or	VBA	to	import	API	data	into	Excel.
Power	Query	simplifies	the	process	by	allowing	you	to	pull	data	from	various	sources.	Open	the	Data	tab,	select	"Get	Data,"	and	choose	"From	Web."	Paste	the	API	URL	and	follow	the	prompts	to	load	the	data	into	your	workbook.	For	developers,	VBA	offers	a	more	customizable	approach.	Use	ActiveX	Data	Objects	or	Data	Access	Objects	in	your	VBA
code	to	retrieve	data.	Define	a	connection	string	to	specify	the	API	details	and	automate	the	import	process.	Both	methods	provide	flexibility	for	managing	real-time	exchange	rates.Creating	Macros	for	Repeated	TasksWriting	a	macro	to	automate	currency	conversionMacros	are	powerful	tools	for	automating	repetitive	tasks	in	Excel.	You	can	write	a
macro	to	handle	currency	conversion	by	recording	your	steps	or	coding	them	in	VBA.	For	example,	a	macro	can	automate	the	process	of	applying	formulas	to	calculate	converted	amounts	or	updating	exchange	rates.	This	saves	time	and	ensures	consistency	across	your	workbook.Example:	Automating	a	multi-currency	reportAutomating	a	multi-
currency	report	with	macros	streamlines	your	workflow.	A	macro	can	pull	exchange	rates,	apply	them	to	your	data,	and	format	the	results.	This	eliminates	manual	intervention	and	reduces	errors.	The	table	below	highlights	the	advantages	of	using	macros:Advantage:Time-saving:	Automates	tasks	that	would	otherwise	require	manual	intervention,
completing	them	quickly.Increased	accuracy:	Reduces	the	risk	of	human	error,	ensuring	consistent	and	accurate	results.Efficiency:	Streamlines	workflows	by	eliminating	repetitive	actions,	allowing	focus	on	more	critical	tasks.Customization:	Tailored	to	fit	specific	requirements,	enabling	personalized	automation	solutions.User-Defined	Functions
(UDFs)Writing	a	custom	function	for	currency	conversionUser-defined	functions	(UDFs)	allow	you	to	create	custom	Excel	functions	using	VBA.	These	functions	are	especially	useful	for	complex	currency	conversion	tasks.	For	instance,	you	can	write	a	UDF	to	fetch	real-time	exchange	rates	from	an	API	and	apply	them	to	your	data.	This	approach
enhances	accuracy	and	simplifies	calculations.Example:	Simplifying	complex	calculations	with	UDFsUDFs	can	handle	advanced	scenarios	like	cross-currency	conversions	or	historical	exchange	rates.	They	can	also	include	robust	error	handling	to	provide	meaningful	error	messages.	For	example,	a	UDF	might	calculate	the	conversion	between	two
currencies	using	historical	exchange	rates	stored	in	your	workbook.	This	flexibility	makes	UDFs	a	valuable	tool	for	managing	intricate	financial	data.	Tip:	Use	UDFs	to	automate	repetitive	calculations	and	reduce	the	risk	of	errors	in	your	currency	conversion	tasks.You	now	have	a	clear	understanding	of	how	to	convert	currency	in	Excel	using	three
main	methods.	Each	method	offers	unique	benefits	depending	on	your	needs.	1.	Using	the	CONVERT	Function	Description:	Converts	various	units,	including	currencies.	Strengths	and	Limitations:	Not	updated	automatically;	limited	to	predefined	currencies.	2.	Importing	Real-Time	Exchange	Rates	Description:	Accesses	current	market	data	for
accurate	conversions.	Strengths	and	Limitations:		Ensures	up-to-date	calculations;	essential	for	financial	analysis.	3.		Using	Web	Queries	Description:	Imports	data	from	external	websites	for	exchange	rates.	Strengths	and	Limitations:	Customizable;	requires	setup	for	reliable	data	sources.To	achieve	professional	results,	explore	advanced	techniques
like	APIs,	macros,	and	user-defined	functions.	These	tools	enhance	efficiency	and	accuracy.	Always	prioritize	proper	formatting	and	double-check	your	formulas	to	maintain	precision	in	your	currency	conversion	tasks.	Tip:	Consistent	formatting	and	updated	data	make	your	financial	reports	more	reliable	and	easier	to	interpret.
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